Introduction to Google Spreadsheets

Google Spreadsheets essentially works in the same way as Microsoft Excel. Both use a format
that is similar to that of an accounting worksheet (i.e. a row and column arrangement) with
individual ‘cells’ normally being identified by a column letter and a row number (e.g. B3 refers
to the cell at the intersection of the second column and the third row). Each cell of a
spreadsheet may contain text, a number or an expression to perform a calculation.

Excel (like most spreadsheet software) must be bought and installed locally on a machine.
Google Spreadsheets however, is an example of a new kind of software that is browser based.
When a spreadsheet is edited, the spreadsheet program is downloaded at that moment to the
users machine (for free).

Small and medium size models work well in Google spreadsheets.

Starting to use Google Documents

To use Google’s on-line applications you must first register /
create a Google account. Open a browser and navigate to Signiin

Email

http://drive.google.com

Click on Create a new Google Account and follow the Password
instructions.

@ Stay signed in

You will need a valid e-mail address - your email address will
become your account name. You will have to authenticate your
account by logging into the mail system and clicking on the
emailed link.

Can't access your account?

Create a new Google Account

Your Google Account is
more than just Google Docs. Name

’ [ ‘ Choose your username
A< -
=d

o]

| prefer to use my current email address
You

Create a password

Confirm your password

Take it all with you.

Birthday

Month =

Gender

lam...

“
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Creating a new spreadsheet

Once you have registered and signed in, you will see the area where = My Drive
your documents and spreadsheets are listed (it should be empty).
Click on Create - Spreadsheet.

i
' Folder

% Document

Presentation

Spreadsheet

Connect more apps

Moving around the spreadsheet

Google Spreadsheets (from here on referred to as GS) uses the traditional highlighted cell,
cursor and cursor key paradigm. The currently edited (or editable) cell is highlighted and
using the arrow keys changes the position of the cursor.

Barry Avery

Untitled spreadsheet Comments
File Edit View Insert Format Data Tools Help
& e ~ T § % 123- Al 10 B 7 s A- % -H-Bd- =-1-5 HM 3
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Developing a Model

The following sections will develop a basic cash-flow model and in doing so, will introduce the
main features and techniques GS offers.

Data Entry

The spreadsheet recognises an entry placed in a cell as either a ‘label’ (i.e. text), ‘Value’ (i.e.
Number) or ‘Formula’ (i.e. calculation). To finish entering the data, press the Enter key |,
which moves the cursor to the cell below.

If any mistakes are made after pressing the Enter key, simply retyping the entry will
‘overwrite’ the current cell content, or pressing the ‘Delete’ key will remove the entry.
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Activity 1: Entering labels and values

Enter the following labels and values on a blank spreadsheet:

A B C D E

1 Jan Feb Mar
Cash
Sales 50 55 60
Credit
Sales 35 32 20
Total
receipts

N

4

-

Note how GS wraps the text if the entry is longer than the given cell width (leave this for the
moment as it will be adjusted later).

Entering Calculations

As is traditional in spreadsheets, cells can also be used to display the results of calculations
based on values in other positions. A calculation (or ‘Formula’) in GS, must be preceded by the
= sign.

Activity 2: Entering a formula

With the cursor at cell C4 type the following formula
=C2+C3 and press the enter key |

This should display the correct total for the figures above.

Activity 3: Adding other formulas

Enter equivalent expressions for the other two months (i.e. in cells D4 and E4).

Once formulae have been entered into a spreadsheet, by clicking the cursor on an existing
number entry then typing in alternative values, the worksheet is immediately recalculated. In
other words you now have a ‘model’ which will work for any range of values.

Activity 4: Demonstrating recalculation

Replace the Credit sales figure for March

with the value 32. You should be able to - 2 g : =
see an immediate recalculation taking / Jan Feb Mar
place. g |Cash
Sales 50 55 60
,  Credit
Sales 35 32 32
4 Total
receipts 85 87 92

Page 3



Accessing the Command Menu
Many operations in spreadsheets are performed by accessing the menu options.

To see the full list of available menu
items, click on the File button. Note
Share... that some items may not be
immediately available.

File Edit View Insert Format Data

New >
Open... 380
Rename...

Make a copy...

Import...

See revision history B\ OC

G)

Spreadsheet settings...

Download as >
Publish to the web...
Email collaborators...

Email as attachment...

0

= Print 38F

Saving and Retrieving Worksheets

The standard options are accessible through the File item (creating, renaming, importing), but
note that you can also download the spreadsheet (to use locally in software such as Excel), or
share the file with others.

Note how there is no ‘file - save’ menu item

Google Docs saves the file regularly in the background so there is no requirement to save the
file like in Excel.
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Activity 5: Extending the model

Extend the current model by adding in entries for Payments and headings for cash flow and

balances as in the illustration below.

1 Jan Feb
Cash
Sales
Credit
Sales
Total

receipts

50 55

35 32

85 87
Wages
& and
salaries
Services
5 Rates
9 Materials
Total
Payments

53
32.5

53

22.5 23

Net cash
flow
Opening
Balance
Closing
Balance

20

Mar

60

32

92

53

15.3
24

Activity 6: Creating Totals

Create calculations for the Total Payments in
cells C10 to E10. Note: the formula for C10
would be =C6+C7+C8+C9 (i.e. include any
blank cells which may require data at a later

stage).

Enter formula for Net Cash Flow calculations
(i.e. Total Receipts minus Total Payments) in

cells C12 to E12.

Wages
and
salaries

Services
Rates
Materials

53
32.5

53

22.5 23

53

15.3
24

Total
Payments

108 76

92.3

Net cash

flow -23 11

-0.3

The Balance calculations now need to be entered. Assuming the January Opening Balance (at
C13)is 20, the January Closing Balance (at C14) is simply created by entering the formula

=C12+C13

This figure needs to be carried forward as the

Opening Balance for February. To do this

simply enter (at D13) the expression

=C14

Net cash

flow -23 1
Opening

Balance 20 -3
Closing

Balance -3 8

This will ensure that any result in cell C14 is also displayed in D13. Enter the equivalent
formulae in columns D and E to complete the calculations for the three months.
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Inserting and Deleting Rows and Columns

D

Click here Feb

to select
A 8 C D E the entire 50 55
Jan Feb Mar column
. ash
° \ﬁales 50 55 60 30 o
85 87
Click here to select the entire row
83 63
32.5
225 23
. . . . t Insert Format Data Tools He
Basic changes to layout can be made by inserting or deleting rows
and columns Row above
Row below
¢ (lick on the row or column heading (above or left of the
sheet - this will highlight the entire row or column) | Column left
* Use the Insert button on the menu bar to either insert a ~ Column right
column/row on the left/right as required.
¢ (lick on any cell to de-select the highlighted column or row
Activity 7: Inserting rows and columns
Click on the row 1 heading and then insert a blank row . - =
at the top of the spreadsheet - enter a title Cash Flow Cash -
Forecast (£000) in cell Al. . Flow
Forecast
. o (£000)
Click on the row 3 heading, insert a row above and enter | : Jan Feb Mar
the heading Receipts in A3. - Eecsipts
as
‘' sales 50 55 60
Click on the row 8 heading, insert another row above ; Cash
and enter the heading Payments in A8. o 3 32 a2
" receipts 85 87 92
Click on the column B heading, then delete the ‘empty’ !
8 Payments
column. Wages
9 and
salaries 53 53 53
10 Services 32.5
11 Rates 15.3
12 Materials 225 23 24
13 Jotal
- Payments
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Changing Column Widths
Any or all of the columns on a worksheet may be adjusted to have different widths.

An individual column can be changed by: T =
A B
1. Positioning the mouse pointer between two column | casp F|®
headings (e.g. A and B), to call up the width change Forecast
cursor (£000)

Width change cursor

2. dragging the column width cursor to right or left, to change the column width

Activity 8: Changing Widths

Increase the width of column A, and reduce the widths of columns B, C and D.

Ranges

A group of cells in a contiguous rectangular block is referred to as a Range in spreadsheets.
They can be defined by typing in their cell references, which is normally the top left corner
address followed by the bottom right corner address separated by a full stop (e.g. B2.D2).

Activity 9: New Month headings

Enter new month headings from April through to June on the second row, (columns E to G).

Using Copy and Paste
Where ‘blocks’ of data need to be copied it is best to use the

Edit View Insert Format Data T

Copy and Paste buttons from under the Edit menu option. ' V"%
To do this you would: ~¥ Redo RY
1. Highlight the block of cells to be copied 3 Cut #X
2. Select the Copy button from the menu bar [} Copy %C
3. Click on the point where the copy is to be placed [ Paste
4. Select the Paste button from the menu bar _
Paste special >

Activity 10: Copy / Paste

Copy the Total Receipts formula for March (in D6), to the next three cells across. This will
resultin 0 entries as there is no data yet for April to June (e6 to g6).

Copy the Total Payments, Net Cash Flow, Opening Balance and Closing Balance calculations (at
D13,D15,D16,D17) using similar sequences to that above.

Enter these extra values: Cash Sales for April, May, June were 50, 55, 60. Credit sales for April,

May, June were 35, 32, 32. Wages were 53 for every month, 32.5 was services for April, with
15.3 as the value for rates in June. Finally materials for April, May, June were 22.5, 23 and 24.
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Functions

To complete the model it is necessary to include Totals for the six months. A simple formula
could be constructed like =~ =B4+C4+D4+F4+G4

However this is rather laborious, especially so for a 12 month cash flow. To simplify repetitive
or complex calculations, spreadsheets provide a number of built-in Functions. These provide
access to a huge range of financial, statistical and mathematical operations.

Each function is entered with the = sign followed by a descriptive word or abbreviation with
data or range information between brackets. The syntax is normally =functionname(data or
range)

The previous total could be entered as:

=SUM(B4:G4) i.e. sum the range from B4 to G4

Activity 11: Adding functions

Enter the heading Total in H2 (alongside the month Headings) and then enter the appropriate
sum function into cell H4.

Use the Copy / Paste technique to copy this formula down from H3 down to H15.

Remove the superfluous functions in rows 7, 8 and 14 by moving to each cell then pressing
the Delete Key.

Selecting Number Formats

A worksheet may display value data in different Format Data Tools Help
ways using the Format menu button. Formatting Number > ol
changes the appearance of the number only, not the .
. ont > 1,000
value stored in the cell. Commonly used ones are: . 100012
Custom Decimals...
B Bold
* Normal - this is usually the default displayed. , | (1000) R
Whole numbers are shown without decimal U Underine ey (1,000.12) Financial
places, numbers that have fractional parts are s swiethrougn \ 1.01E+03
shown with as many places as room permits. $1,000 Gurency
$1,000.12 Currency
° NumberS _ Permits ChOice Of deCimal places Conditional formatting... More currencies
and how negative figures are displayed. Tx Clear formatting 10% Percent rounded
10.12% Percent
* Currency - Provides a currency symbol, 912612008 pate
. . . 15:569:00 me
along with a ;" delimited thousands separator '
. . . 9/26/2008 15:59:00  Date time
and choice of fixed decimal places. 24:01:00

More formats

Plain text
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Activity 12: Formatting cells

Highlight all the values (e.g. in the range B4.H17). Select the Format button to call up the
Format choices. Choose two decimal places for all the cells.

To set the Total column differently (e.g. to be rounded up to whole numbers), highlight the
Total values (in the range H4.H15), select the Format button again and choose rounded.

The Tool Bar

Standard spreadsheet functionality is available through the buttons on the Tool Bar. Select the
area or range of cells to be affected and then click on the appropriate button.

& e~ $ % 123- Aral 10 B 7 5 A- ®-H 1 -5 HM z

Hover the mouse pointer over each item in turn to see a pop up explaining the purpose of each
button. You will use the Align and Borders buttons in the next activities

Aligning Cell Entries

Alignment in a cell may be chosen to be Left, Centre or Right by simply clicking on the Align
button.

Activity 13: Align the headings

Use the tool bar to ‘Right’ align the month headings.

Borders
The Borders facility which makes it easy to create ‘boxed’ tables in all or part of a spreadsheet.

Activity 14: Placing borders

To Emphasise the Receipts figures and calculations place the cursor at A4 (the Cash Sales line)
then highlight to cell H6. Click on the Borders button and select the ‘borders-round-all-cells’
option.

Place borders around the Payments figures (rows 9 to 13) and the final three rows of
calculations (rows 15 to 17).

A B
Cash Flow Forecast (£000)

(]
o
m
T
(]
T

Jan Feb Mar Aprii May June Totals

1
3 Receipts

4 Cash Sales 50.00| 55.00| 60.00| 50.00| 55.00| 60.00 330
5  Credit Sales 35.00( 32.00( 32.00| 35.00| 32.00| 32.00 198
6  Total receipts 85.00( 87.00| 92.00| 85.00| 87.00) 92.00 528
5  Payments

9  Wages and salaries 53.00( 53.00| 53.00| 53.00| 53.00| 53.00 318
10 Services 32.50 32.50 65
11 Rates 15.30 15.30 31
12 Materials 22.50| 23.00| 24.00| 22.50| 23.00( 24.00 139
13 Total Payments 108.0() 76.00) 92.30(108.0C| 76.00| 92.30 553
14

15 Net cash flow -23.00| 11.00| -0.30(-23.00( 11.00{ -0.30 -25
16 Opening Balance 20.00| -3.00f 8.00| 7.70|-15.30{ -4.30 13
17 Closing Balance -3.00( 8.00 7.70|-15.30| 4.30| -4.60 -12
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Importing, exporting and collaborating

Two important features offered by Google
Spreadsheets are importing/exporting
and collaboration.

File Edit View Insert Format Data Tools Help

Share...

New

Open... %0 ¢ D e
Exporting e
Google Spreadsheets can export files in a mport..
variety of different forms, including PDF, o o
HTML and the native Excel format XLSX. z:::;::;:':::;s e ——
To do this select the File menu button Download as > Microsoft Excel (xisx)

Publigh to the web... OpenDocument format (.ods)

followed by Download as and the export
form of your choice.

Email collaborators... PDF document (.pdf)

Email as attachment... Comma Separated Values (.csv, current sheet)

& Print sop  Plain text (.txt, current sheet)

Web page (.html, current sheet)

Activity: Exporting to Excel

Use the export functionality to export the completed spreadsheet to your local network area
as an Excel spreadsheet.

Next, load the spreadsheet into Excel and change the format so that it looks like the following:

Cash Flow Forecast (£000)
Jan Feb Mar April May June Totals

Receipts
Cash Sales 50 55 60] 50[ 55 60 330
Credit Sales 35| 32| 32[ 35 32 32 198
Total receipts 85| 87| 92 85 87 92 528
Payments

| Wages and salaries 53] 53] 53] 53] 53 53 318
Senices 32.5 32.5 65
Rates 15.3 15.3 31
Materials 225 23| 24| 225] 23 24 139
Total Payments 108 76| 92.3] 108 76| 92.3 553
Net cash flow -23 1] -0.3] -23 1] -0.3 -25
Opening Balance 20 -3 8 7.7[-153] 43 13
Closing Balance -3 8] 7.7[-15.3] 43| 46 -12

Hints: Change the background colour of the cells to be a light grey colour, and use Bold/Italic
asrequired. Save the spreadsheet

Importing
Some formatting features from Excel may be lost during the import process.

Activity: Importing back into Google Drive

In Google documents, Select New Spreadsheet and then use File — Import to load in the Cash
Flow spreadsheet. How much of the formatting has survived the import process?
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Collaboration

An Google spreadsheet can be shared with another user. Barry Avery
For this next activity you will need to work in pairs, with D
someone who has also got this far in the activity. You will Comments e
need to know each others email address.

Activity: Share a spreadsheet online

In Google Spreadsheets, with the Cash Flow spreadsheet open, use the share button item (on
the right) to invite someone to collaborate on the document. One of you should share the
spreadsheet, the other should follow the invite from the email.

Follow the email link (and look in Google Spreadsheets) for the shared file.

You should now both be able to Discuss and change the file (using the Discuss option on the
right).

Activity: Make changes collaboratively

With both of you viewing the same spreadsheet, try out the Discuss option, and then (between
you) change the figures so that:

The Cash Sales for May are 65

The Credit Sales for June are 64

Wages and salaries go up to 60 in May and June

Materials costs increase in May and June (add on 10 to the two existing values).
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